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1. Перечень компетенций с указанием этапов их формирования в процессе освоения 

образовательной программы 

 

Изучение дисциплины «Микропроцессорное управление в проектной 

деятельности» позволяет сформировать у бакалавров следующие 

компетенции. 

 
Код и наименование компетенции Этапы формирования 

ДПК-3 Способен организовывать 

деятельность обучающихся, направленную 

на развитие и поддержание у них 

познавательной активности, 

самостоятельности, инициативы и 

творческих способностей 

1. Работа на учебных занятиях. 

2. Самостоятельная работа. 

 

СПК-1 «Способен освоить современные 

концепции, теории, законы и методы в 

области физики, математики и 

информатики, овладеть основными 

методами решения задач, 

сформулированными в рамках данных 

предметных областей, и применить их в 

профессиональной деятельности» 

1. Работа на учебных занятиях. 

2. Самостоятельная работа. 

 

 
 

2. Описание показателей и критериев оценивания компетенций на различных этапах 

их формирования, описание шкал оценивания 

 

Оцениваемые 

компетенции 

Уровень 

сформиро-

ванности 

Этап 

формирования 
Описание показателей 

Критерии 

оценивания 

Шкала 

оценивания 

ДПК-3 Пороговый 1. Работа на 

учебных занятиях. 

2.Самостоятельная 

работа. 

 

Знает: 

- научно-методические основы 

планирования педагогической 

деятельности; 

- методический потенциал 

преподаваемого предмета; 

систему оценки результатов 

освоения обучающимися 

предметного содержания. 

 

Умеет: 

- реализовывать методический 

потенциал преподаваемого 

предмета для достижения 

образовательных целей; 

- использовать систему оценки 

результатов освоения 

обучающимися предметного 

содержания. 

 

Текущий 

контроль 

(выполнени

е 

лабораторн

ых работ и 

домашних 

заданий, 

тестировани

е), 

посещение, 

конспект, 

курсовая 

работа, 

зачет с 

оценкой 

41-60 

Продвинутый 1. Работа на 

учебных занятиях. 

2.Самостоятельная 

работа. 

 

Знает: 

- научно-методические основы 

планирования педагогической 

деятельности; 

- методический потенциал 

Текущий 

контроль 

(выполнени

е 

лабораторн

61-100 
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преподаваемого предмета; 

систему оценки результатов 

освоения обучающимися 

предметного содержания. 

 

Умеет: 

- реализовывать методический 

потенциал преподаваемого 

предмета для достижения 

образовательных целей; 

- использовать систему оценки 

результатов освоения 

обучающимися предметного 

содержания. 

 

Владеет: 

- опытом реализации 

методического потенциала 

преподаваемого предмета для 

достижения образовательных 

целей; 

- опытом использования 

системы оценки результатов 

освоения обучающимися 

предметного содержания. 

 

ых работ и 

домашних 

заданий, 

тестировани

е),  

конспект, 

курсовая 

работа 

посещение, 

зачет с 

оценкой 

СПК-1 Пороговый 1. Работа на 

учебных занятиях. 

2.Самостоятельная 

работа. 

 

Знает: 

- современные концепции, 

теории, законы и методы в 

области информатики и 

перспективные направления 

развития современной науки; 

- значение и место 

дисциплин физико-

математического цикла в общей 

картине мира. 

 

Умеет: 

- ясно и логично излагать 

полученные базовые знания; 

- демонстрировать понимание 

общей структуры дисциплин 

физико-математического цикла и 

взаимосвязи их с другими 

дисциплинами; 

- строить модели реальных 

объектов или процессов; 

- профессионально решать 

задачи, связанные с предметной 

областью, с учетом современных 

достижений науки; 

- применять информационно-

коммуникационные технологии 

для эффективного решения 

научных и прикладных задач, 

связанных с предметной 

областью. 

Текущий 

контроль 

(выполнени

е 

лабораторн

ых работ и 

домашних 

заданий, 

тестировани

е),  

конспект, 

курсовая 

работа 

посещение, 

зачет с 

оценкой 

41-60 

Продвинутый 1. Работа на 

учебных занятиях. 

2.Самостоятельная 

работа. 

 

Знает: 

- современные концепции, 

теории, законы и методы в 

области информатики и 

перспективные направления 

развития современной науки; 

Текущий 

контроль 

(выполнени

е 

лабораторн

ых работ и 

61-100 
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3. Типовые контрольные задания или иные материалы, необходимые для оценки 

знаний, умений, навыков и (или) опыта деятельности, характеризующих этапы 

формирования компетенций в процессе освоения образовательной программы  

 

Тестовые задания для текущего контроля:  

 

7 семестр  

Вариант 1 

Дополните предложение  

1. ___________________ - это совокупность электротехнических устройств, объектов 

(источников, приемников электроэнергии, коммутационных, защитных аппаратов и 

пр.) и соединяющих их проводников, представляющих собой путь для 

прохождения электрического тока. 

 

Выберите один правильный ответ 

2. Мощность – это… 

a. мера скорости трансформации электрической энергии в другую форму 

b) соединение плюса с минусом напрямую 

- значение и место 

дисциплин физико-

математического цикла в общей 

картине мира. 

 

Умеет: 

- ясно и логично излагать 

полученные базовые знания; 

- демонстрировать понимание 

общей структуры дисциплин 

физико-математического цикла и 

взаимосвязи их с другими 

дисциплинами; 

- строить модели реальных 

объектов или процессов; 

- профессионально решать 

задачи, связанные с предметной 

областью, с учетом современных 

достижений науки; 

- применять информационно-

коммуникационные технологии 

для эффективного решения 

научных и прикладных задач, 

связанных с предметной 

областью. 

 

Владеет: 

- способностью к логическому 

рассуждению; 

- моделированием для 

построения объектов и 

процессов, определения или 

предсказания их свойств; 

- владеет основными методами 

решения задач, 

сформулированными в рамках 

предметных областей. 

 

домашних 

заданий, 

тестировани

е),  

конспект, 

курсовая 

работа 

посещение, 

зачет с 

оценкой 
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a. измерение напряжения вокруг разных компонентов цепи можно с помощью 

вольтметра 

c) собственное сопротивление проводника 

 

3. Установите соответствие: 

a) Рекомендуемое (номинальное) напряжение 1) IS Ампер 

b) Потребляемый ток без нагрузки  2) V Вольт 

c) Потребляемый ток при блокировке 3) ω с-¹ 

d) Скорость вращения без нагрузки 4) τ Н×м 

e) Максимальный крутящий момент 5) IF Ампер 

 

 

Выберите один или несколько правильных ответов.  

4. Какие из следующих идентификаторов корректны и не вызовут ошибку? 

a) 13pin 

b) MOTOR_1 

c) контакт_светодиода 

d) sensor value 

e) leftServo 

f) my-var 

 

Выберите один правильный ответ 

5.  Какое усредненное напряжение мы получим на пине 6, если вызовем функцию 

analogWrite (6, 153) 

a) Не получим напряжения 

b) 2В 

c) 3В 

d) 5В 

 

Дополните предложение. 

6. Отношение времени включения и выключения называют _________ - от англ. duty 

cycle 

 

Выберите один правильный ответ 

7. Отметьте пункт, не являющийся элементом платы Arduino UNO 

a) светодиод 

b) микроконтроллер 

c) жесткий диск 

d) USB порт 

 

 

 

Установите правильный порядок. 

8. Установите правильный порядок работы с программным обеспечением Arduino 

IDE и платой Arduino UNO 

№ ШАГ 

 Скачивание Arduino IDE с официального сайта  

 Подключение Arduino к компьютеру через USB 

 Нажатие кнопки «Upload» на панели инструментов  

 Если у вас Windows и Arduino IDE из zip-файла, установите драйверы из 

папки drivers 

 В «Tools → Board» выбор модели вашей платы 
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 Написание программы или загрузка готового примера из «File → Examples» 

 В «Tools → Serial Port» выбор порта, куда плата подключена 

 Запуск Arduino IDE 

 

Выберите один правильный ответ 

9. Механизм, замыкающий цепь пока есть давление на толкатель –  это… 

a) светодиод 

b) тактовая кнопка 

c) реостат 

d) потенциометр 

 

Дополните предложение. 

10. Потенциометр еще называют __________________, триммером. Это делитель из 

двух резисторов в одном корпусе. Поэтому у него 3 «ножки»: питание, выход, 

земля. Соотношение R1 и R2 меняется поворотом ручки. От 100% в пользу R1 до 

100% в пользу R2. 

 

Выберите один правильный ответ 

11.  Как будет работать вызов tone без указания длительности звучания при работе с 

пьезопищалкой? 

a) будет звучать беспрерывно 

b) не будет звучать 

c) примет наиболее низкий доступный тон 

d) примет наиболее высокий доступный тон 

 

Дополните предложение.  

12. Светодиоды стоит подключать в _________________ соединении с резистором. На 

каждый сегмент необходим отдельный резистор. 

 

Соотнесите 

13.  Соотнесите основные характеристики пьезодинамика и их единицы измерения. 

 

 

 

Выберите один или несколько правильных ответов.  

14. При возникновении проблем с прошивкой платы следует: 

a) проверить получает ли плата питание, горит светодиод «ON» 

b) проверить, чтоДрайверы под Windows установились корректно, и в 

диспетчере устройств вы видите устройство «Arduino Uno» 

c) проверить правильность выбора модели платы и правильность выбранного 

порта 

d) исправность USB-кабеля 

 

Дополните предложение. 

a) Рекомендуемое (номинальное) напряжение 1) C Фарад 

b) Пиковая частота 2) V Вольт 

c) Ёмкость 3) P Децибелл 

d) Громкость (на заданном расстоянии) 4) fP Герц 
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15.  Амплитудно-частотная характеристика (АЧХ) определяет громкость звука в 

зависимости от_______________________, который и определяет высоту звучащей 

ноты. 

 

Вариант 2 

 

Выберите один или несколько правильных ответов.  

1. Какие из следующих идентификаторов некорректны и вызовут ошибку? 

a) 13pin 

b) MOTOR_1 

c) контакт_светодиода 

d) sensor value 

e) leftServo 

f) my-var 

g) distance_eval2 

 

Выберите один правильный ответ 

2. Ограничивает силу тока, переводя часть электроэнергии в тепло 

a) резистор 

b) потенциометр 

c) светодиод 

d) тактовая кнопка 

 

Дополните предложение.  

3. Пьезоизлучатель звука (англ. buzzer) переводит ___________________ в колебание 

мембраны, которая в свою очередь создает звуковую волну. 

 

Выберите один или несколько правильных ответов. 

4. Отметьте пункт(ы), являющийся(иеся) элементом(ами) платы Arduino UNO 

a) Светодиод 

b) Микроконтроллер 

c) Жесткий диск 

d) USB порт 

 

5. Установите соответствие: 

a) Скорость вращения без нагрузки 1) V Вольт 

b) Максимальный крутящий момент 2) IS Ампер 

c) Потребляемый ток без нагрузки  3) IF Ампер 

d) Рекомендуемое (номинальное) напряжение  4) τ Н×м 

e) Потребляемый ток при блокировке 5) ω с-¹ 

 

Выберите один правильный ответ 

6. При замыкании и размыкании между пластинами кнопки возникают микроискры, 

провоцирующие до десятка переключений за несколько миллисекунд. Такое 

явление называется …….. 

a) скважностью 

b) стягиванием 

c) искрением 

d) дребезгом 

 

Дополните предложение.  
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7. Соединение плюса с минусом напрямую, по закону Ома, приводит к очень 

большому току, следовательно к очень большой мощности нагрева, что в итоге 

приводит к возгоранию. Это называется_________________. Никогда не 

допускайте его, ни при каких обстоятельствах! 

 

Выберите один или несколько правильных ответов.  

8. Что из перечисленного не является резистивным датчиком? 

a) термистор 

b) фоторезистор 

c) потенциометр 

d) резистор 

e) светодиод 

 

Выберите один правильный ответ 

9. Процедура, обычно используемая для конфигурации портов микроконтроллера и 

других настроек 

a) Loop 

b) Setup 

c) Void 

d) Void loop 

 

Соотнесите данные в таблице 

10. Соотнесите основные характеристики светодиода и их единицы измерения. 

a) Номинальный ток 1) IV Кандела 

b) Интенсивность (яркость) 2) λ Нанометр 

c) Падение напряжения 3) VF Вольт 

d) Длина волны (цвет) 4) I Ампер 

 

Выберите один правильный ответ 

11.  Главный закон электричества – это  

a) Закон Ома 

b) Закон импенданса 

c) II закон Ньютона 

d) «Не влезай – убьёт!» 

 

Дополните предложение.  

12. При _________________________ сила тока в каждом потребителе - одна и та же, 

различается напряжение: в каждом компоненте падает его часть. 

 

Выберите один правильный ответ. 

13.  При работе с пьезопищалкой параметр duration не является обязательным. Если 

его не передать, то … 

a) пьезопищалка не будет работать  

b) пьезопищалка будет звучать непрерывно 

c) для звучания пьезопищалки потребуется более высокое напряжение 

d) плата Arduino UNO выйдет из строя 

 

Выберите один или несколько правильных ответов. 

14. Для определения номинала резистора следует: 

a) ознакомиться с таблицей маркировки 

b) использовать мультиметр 

c) резисторы не имеют номинала 
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d) замкнуть им контакты батарейки 

 

Установите правильный порядок. 

15.  Установите правильный порядок работы с программным обеспечением Arduino 

IDE и платой Arduino UNO 

№ ШАГ 

 Запуск Arduino IDE 

 Подключение Arduino к компьютеру через USB 

 В «Tools → Board» выбор модели вашей платы 

 Если у вас Windows и Arduino IDE из zip-файла, установите драйверы из 

папки drivers 

 Нажатие кнопки «Upload» на панели инструментов  

 В «Tools → Serial Port» выбор порта, куда плата подключена  

 Написание программы или загрузка готового примера из «File → Examples» 

 Скачивание Arduino IDE с официального сайта 

 

8 семестр 

Вариант 1 

 

Выберите один правильный ответ. 

1. Не любой порт Arduino поддерживает широтно-импульсную модуляцию, если вы 

хотите регулировать напряжение, вам подойдут пины, помеченные символом … 

(Для Arduino Uno это пины 3, 5, 6, 9, 10, 11) 

a) $ 

b) # 

c) - 

d) ~ 

 

Какому элементу соответствует данное описание. Выберите один правильный ответ. 

2. Это электрический «ниппель». У него есть 2 полюса: анод и катод. Ток 

пропускается только от анода к катоду. 

a) диод 

b) лампа накаливания 

c) реле 

d) резистор 

 

Выберите один правильный ответ 

3. Принципиальная схема какого элемента изображена на рисунке? 

 
a) светодиод 

b) семисегментный индикатор 

c) Светодиодная шкала 

d) беспаечная макетная плата 
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Дополните предложение. 

4. В отличие от ________________ полевой контролируется именно напряжением, а 

не током. Т.е. в открытом состоянии ток через затвор не идёт. 

 

Соотнесите информацию в таблице. 

5.  Соотнесите основные характеристики биполярного транзистора и их единицы 

измерения. 

a) Сопротивление сток-исток 1) VDS Вольт 

b) Рассеиваемая мощность 2) RDSon Ом 

c) Максимальный ток через сток 3) PD Ватт 

d) Максимальное напряжение 

сток-исток 

4) I D Ампер 

 

Выберите один или несколько правильных вариантов.  

6. Идентификаторы переменных, констант, функций могут состоять из: 

a) из букв латинского алфавита 

b) из букв русского алфавита 

c) цифр 

d) символов пробела 

e) символов подчеркивания 

f) точек 

 

 

Выберите один правильный ответ 

7. Переменным принято давать названия, начинающиеся … 

a) строчной буквы 

b) заглавной буквы 

c) звездочки 

d) символа нижнего подчеркивания 

 

Выберите один правильный ответ 

8. За условным оператором if обязательно следует блок кода, который выполняется в 

случае … 

a) истинности логического выражения. 

b) необходимости логического выражения 

c) ложности логического значения 

d) критической ошибки 

 

9. Продолжите блок кода для возможности его выполнения. 

 void setup()  

{  

pinMode(13, OUTPUT);  

}  

void loop()  

{  

digitalWrite(13, HIGH);  

delay(100);  

digitalWrite(13, LOW);  

delay(900 

… 

 

Выберите один правильный ответ 
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10.  Какое название наиболее подходит для прибора, принципиальная схема которого 

изображена ниже? 

 
a) кнопочный переключатель 

b) бегущий огонёк 

c) пульсар 

d) терменвокс 

 

Дополните предложение.  

11. Фоторезистор (англ. Light Dependent Resistor или сокращённо LDR) изменяет своё 

________________ в зависимости от силы света, попадающего на его 

керамическую «змейку». 

 

Выберите один правильный ответ 

12.  На изображенном ниже рисунке показана принципиальная схема: 

 

 
a) выпрямительного диода 

b) светодиода 

c) диода Зеннера 

d) диода Шоттки 

 

Выберите один правильный ответ 

13.  Крошечный аккумулятор, который очень быстро заряжается и очень быстро 

разряжается – это  

a) батарейка 

b) диод 

c) конденсатор 

d) дросель 

 

Выберите один правильный ответ 

14. Какой элемент отсутствует на рисунке изображенном ниже? 
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a) потенциометр 

b) светодиод 

c) резистор 

d) соединительного провод 

 

Дополните предложение.  

15. Собственное сопротивление светодиода после насыщения очень мало, и без 

____________, ограничивающего ток через светодиод, он перегорит.  

 

Вариант 2 

 

Выберите один правильный ответ 

1. Не любой порт Arduino поддерживает широтно-импульсную модуляцию, если вы 

хотите регулировать напряжение, вам подойдут пины, помеченные специальным 

символом тильда «~». Для Arduino Uno это пины … 

a) 3, 5, 6, 9, 10, 11 

b) 1, 2, 4 

c) 1, 2, 4, 7, 12, 13 

d) 0, 1 

 

Выберите один правильный ответ 

2. Какому элементу соответствует данное описание? 

Это искусственное «препятствие» для тока. Сопротивление в чистом виде. 

Ограничивает силу тока, переводя часть электроэнергии в тепло. 

a) диод 

b) лампа накаливания 

c) реле 

d) резистор 

 

Выберите один правильный ответ 

3. Принципиальная схема какого элемента изображена на рисунке? 

 
a) светодиод 

b) семисегментный индикатор 

c) светодиодная шкала 

d) беспаечная макетная плата 

 

Дополните предложение. 

4. Микроконтроллеры обычно не могут выдавать произвольное напряжение. Они 

могут выдать либо напряжение питания (например, 5 В), либо ____________ 

 

Соотнесите данные в таблице. 

5. Соотнесите основные характеристики диодов и их единицы измерения. 

1. Максимальное сдерживаемое 

обратное напряжение 

1) IF Ампер 

2. Максимальный прямой ток 2) VDC Вольт 

3. Падение прямого напряжения 3) VF Вольт 
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Выберите один или несколько вариантов. 

6. Идентификаторы переменных, констант, функций не могут состоять из: 

a) из букв латинского алфавита 

b) из букв русского алфавита 

c) цифр 

d) символов пробела 

e) символов подчеркивания 

f) точек 

 

7. Допиши начало блока так, чтобы код выполнялся. 

pinMode(13, OUTPUT); 

} 

void loop() 

{ 

digitalWrite(13, HIGH); 

delay(100); 

digitalWrite(13, LOW); 

delay(900); 

} 

… 

 

Выберите один или несколько вариантов. 

8. Переменным не принято давать названия, начинающиеся … 

a) строчной буквы 

b) заглавной буквы 

c) звездочки 

d) символа нижнего подчеркивания 

 

Выберите один правильный ответ 

9. Какое название наиболее подходит для прибора, принципиальная схема которого 

изображена ниже? 

 
 

a) кнопочный переключатель 

b) бегущий огонёк 

c) пульсар 

d) терменвокс 

 

Дополните предложение. 

10. Потенциометр ещё называют переменным резистором, триммером. Это делитель из 

двух резисторов в одном корпусе. Поэтому у него 3 «ножки»:  

________________________________________. 

 

Выберите один правильный ответ 

11.  На изображенном ниже рисунке показана принципиальная схема: 
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a) выпрямительного диода 

b) светодиода 

c) диода Зеннера 

d) диода Шоттки 

 

Выберите один правильный ответ 

12.  LED_PIN, LED_pin и led_pin с точки зрения компилятора … 

a) не являются идентификаторами 

b) различные идентификаторы 

c) одинаковые идентификаторы 

d) непонятный набор знаков 

 

Отметьте один или несколько правильных ответов. 

13. Какого(их) элемента(ов) нет на рисунке, изображенном ниже? 

 
a) потенциометра 

b) светодиода 

c) резистора 

d) соединительного провода 

e) пьезопищалки 

f) конденсатора 

 

 

 

 

Дополните предложение. 

14. _______________________— это его средняя ножка. Если повернуть транзистор 

плоской стороной к себе, ножками вниз, то левая ножка это коллектор, а правая — 

эмиттер. 

 

Выберите один правильный ответ 

15.  Но уровнем напряжения управляется многое: например, яркость светодиода или 

скорость вращения мотора. Для симуляции неполного напряжения используется: 

a) скважность 

b) дребезг 

c) широтно-импульсная модуляция 

d) прототипирование 
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Лабораторные работы по дисциплине  

7 семестр 

Раздел 1. Основы робототехнических систем 

Тема 5. Управление движением манипулятора (6 ч.) 

Цель: знакомство с элементами робототехнического конструктора Lego WeDo 2.0. 

 

Тема 6. Колесные мобильные роботы (6 ч.) 

Цель: знакомство с элементами робототехнического конструктора Lego EV3. 

 

Тема 7. Обработка и объедение данных с различных датчиков (6 ч.) 

Цель: управление датчиками робототехнического конструктора Lego EV3. 

 

Тема 8. Архитектура системы управления (6 ч.) 

Цель: управление датчиками робототехнического конструктора Lego EV3. 

 

8 семестр 

Раздел 2. Разработка и проектирование компонентов робототехнических систем на основе 

микроконтроллера Arduino 

Тема 1. Знакомство с Arduino (4 ч.) 

Цель: познакомиться с основными электронными элементами для программирования 

умных устройств на базе микроконтроллера Arduino.  

 

Тема 2. Основы работы с языком программирования для микроконтроллера (12 ч.) 

Цель: познакомиться с командами, служебными словами и основными конструкциями 

языка С++ на основе реализации мини-проектов в сетевой среде. 

• Создание простейшего электронного устройства – мигающего светодиода. 

• Создание простейшего электронного устройства – мигающего светодиода с 

нарастающей яркостью. 

 

Тема 3. Функции, массивы и строки (10 ч.) 

Цель: знакомство с функциями, массивами и строками в языке С++ на основе реализации 

мини-проектов в сетевой среде. 

• Создание светильника с управляемой яркостью. 

• Создание простейшего электронного устройства – терменвокса. 

 

Тема 4. Ввод и вывод данных (10 ч.) 

Цель: знакомство со способами ввода и вывода данных в языке С++ на основе реализации 

мини-проектов в сетевой среде. 

• Создание устройства, которое наращивает яркость светодиодной шкалы. 

• Создание простейшего электронного устройства – бегущий огонек. 

 

Тема 5. Стандартные библиотеки и Arduino (10 ч.) 

Цель: знакомство со стандартными и подключаемыми библиотеками в языке С++ . 

• Создание триггера из тактовой кнопки. 

• Добавление яркости светодиоду одной кнопкой, а убавление другой. 

 

Тема 6. Жидкокристаллические дисплеи (10 ч.) 

Цель: создание мини-проектов с использованием жидкокристаллических дисплеев. 

• Создание устройства с семисегментным индикатором, на который выводится 
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количество нажатий на кнопку. 

• Измерение температуры окружающей среды и с помощью шкалы. 

 

Тема 7. Программирование Arduino Ethernet (10 ч.) 

Цель: реализация проектов на основе полученных ранее знаний:  

• Создание светильника, включающегося при падении уровня освещенности. 

• Создание простейшего электронного устройства – музыкальной клавиатуры. 

• Создание простейшего электронного устройства – миксера. 

• Создание секундомера. 

 

Тема 8. Моделирование и конструирование компонентов робототехнических систем на 

основе микроконтроллера Arduino (32 ч.) 

Цель: создание сложных проектов на основе полученных ранее знаний:  

• Проект «Светофор». 

• Проект «Ночной светильник». 

• Проект «Игра – скорость реакции». 

• Проект «Метеостанция». 

• Проект «Тестер батареек». 

 

Домашние задания по дисциплине  

 

Задание 1. Пульт дистанционного управления. 

Разработать проект универсального пульта дистанционного управления управляемого со 

смартфона. 

 

Задание 2. Светильник, управляемый по USB. 

Разработать проект RGB светильника управляемого со смартфона. 

 

Задание 3. Датчик температуры. 

Разработать проект электронного устройства, позволяющего наблюдать и записывать 

температуру на удаленном сервере в режиме реального времени. 

 

Задание 4. Таймер с детектором движения. 

Разработать проект LCD часов с сигнализацией и таймером, срабатывающий на детектор 

движения.  

 

Задание 5. Передача фото с камеры на веб-страницу. 

Разработать проект, используя плату Arduino и модуль Ethernet Shield для передачи фото с 

камеры на веб-страницу. 

Самостоятельная работа 

 

Целью самостоятельной работы является углубление понимания и улучшение 

усвоения курса лекций и лабораторных работ, подготовка к выполнению контрольных 

работ и к сдаче зачета. 

 

№ 

Темы для 

самостоятельного 

изучения 

Изучаемые 

вопросы 

Кол-во 

часов 

Формы 

самостоятельной 

работы 

Методическое 

обеспечение 

Формы 

отчетности 

1.  Многопроцес-

сорные системы. 

Состав. 

Основные 

функции и 

возмож-

2 Работа с 

литературой и 

сетью Интернет. 

Рекомендуемая 

литература. 

Ресурсы 

Интернет. 

Конспект. 
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№ 

Темы для 

самостоятельного 

изучения 

Изучаемые 

вопросы 

Кол-во 

часов 

Формы 

самостоятельной 

работы 

Методическое 

обеспечение 

Формы 

отчетности 

ности. 

2.  Встроенные 

операционные 

системы 

микрокомпью-

теров.  

Общие 

принципы. 

Перспекти

вы 

развития. 

4 Работа с 

литературой и 

сетью Интернет. 

Рекомендуемая 

литература. 

Ресурсы 

Интернет. 

Конспект. 

3.  Основные 

направления 

развития 

робототехники в 

образовании. 

Общие 

принципы. 

Перспек-

тивы 

развития. 

Образова-

тельные 

проекты. 

4 Работа с 

литературой и 

сетью Интернет. 

Рекомендуемая 

литература. 

Ресурсы 

Интернет. 

Конспект. 

4.  Образовательная 

робототехника 

на основе 

платформы Lego 

Mindstorms.  

Общие 

принципы. 

Перспек-

тивы 

развития. 

Образова-

тельные 

проекты. 

4 Работа с 

литературой и 

сетью Интернет. 

Рекомендуемая 

литература. 

Ресурсы 

Интернет. 

Конспект. 

5.  Образовательная 

робототехника 

на основе 

платформы 

Arduino.  

Общие 

принципы. 

Перспек-

тивы 

развития. 

Образова-

тельные 

проекты. 

4 Работа с 

литературой и 

сетью Интернет. 

Рекомендуемая 

литература. 

Ресурсы 

Интернет. 

Конспект. 

 Итого  18    

 

 

Вопросы к зачету с оценкой в 7 семестре  

 

1. Робототехника. Робот. Функциональная схема робота. 

2. Манипуляционные системы. Классификация манипуляционных систем. 

3. Устройство роботов: система передвижения, исполнительный орган, сенсорная 

система, датчики, приводы.  

4. Особенности системы управления роботом. 

5. История и современное состояние робототехники. 

6. Основные понятия теории управления.  

7. Принципы управления. Классификация систем управления. 

8. Структура цифровой системы управления. 

9. Управление движением манипулятора. 

10. Колесные мобильные роботы. 

11. Управление движением мобильных роботов. 

12. Микроконтроллер Arduino. Компоненты Arduino.  

13. Резистор. Светодиод. 
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14. Изменение яркости светодиода с использованием широтно-импульсной модуляции 

15. Транзистор. Выпрямительный диод. Реле. 

16. Принципиальная схема. Чтение принципиальных схем. 

17. Программирование Arduino. 

18. Классы и методы. 

19. Создание библиотек. 

20. Случайные числа. 

21. Математические функции. 

22. Операции с битами. 

23. Функции ввода/вывода. 

24. Генерирование звуковых сигналов. 

25. Прерывания. 

 

Вопросы к зачету с оценкой в 8 семестре  

 

1. Макетные платы и их разновидности. 

2. Числовые переменные и арифметические операции. 

3. Вещественные переменные. 

4. Операторы сравнения чисел. 

5. Команды. Циклы. Функции. 

6. Типы данных. Оформление программного кода. 

7. Организация массивов. 

8. Ввод и вывод данных в Arduino.  

9. Цифровые и аналоговые входы и выходы.  

10. Стандартная библиотека Arduino. 

11. Математические функции. 

12. Дополнительные функции ввода и вывода. 

13. Жидкокристаллические дисплеи. 

14. Определение собственных символов. 

15. Семисегментные и светодиодные индикаторы. 

16. Управление семисегментными индикаторами. 

17. Программирование Arduino Ethernet. 

18. Выполнение арифметических операций в Arduino. 

19. Платы расширения Arduino. 

20. Прерывания в Arduino. 

21. Сенсорные экраны. 

22. Электродвигатели и движение. 

23. Плата расширения Ethernet 

24. Обмен данными с серверами. 

25. Настройка контактов Arduino по сети. 

 

 

 

Темы курсовых работ в 8 семестре 

 

1. Современные микропроцессоры. 

2. Интерфейсы периферийных устройств. 

3. Архитектура материнских плат. 

4. Многопроцессорные системы. 

5. Современные архитектуры вычислительных систем. 

6. Архитектура универсальных микропроцессоров. 

7. Архитектура микропроцессоров. 
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8. Суперкомпьютеры. 

9. Нейрокомпьютеры. 

10. Микропроцессоры мобильных систем. 

11. Нанороботы. 

12. Биороботы. 

13. Робототехника в современном мире. 

14. Программное обеспечение для программирования робототехнических систем. 

15. Прошлое и будущее робототехники. 

16. Промышленная робототехника. 

17. Конструкторы программируемых роботов. 

18. Образовательные робототехнические системы. 

19. Образовательная робототехника на основе платформы Lego Mindstorms. 

20. Образовательная робототехника на основе микроконтроллера Arduino. 

21. Искусственный интеллект в робототехнике. 

22. Моделирование и конструирование в робототехнике. 

23. Бионика и эволюционная робототехника. 

24. Мехатроника и робототехника. 

25. Вычислительные устройства в системах управления роботов. 

 

4. Методические материалы, определяющие процедуры оценивания знаний, умений, 

навыков и (или) опыта деятельности, характеризующих этапы формирования 

компетенций 

 

Оценивание степени освоения обучающимися дисциплины осуществляется на 

основе «Положение о балльно-рейтинговой системе оценки успеваемости студентов 

МГОУ». 

Шкала соответствия рейтинговых оценок пятибалльным оценкам:  

 

Оценка по 5-балльной системе Оценка по 100-

балльной системе 

5 отлично 81 – 100 

4 хорошо 61 – 80 

3 удовлетворительно 41 – 60 

2 неудовлетворительно 21 – 40 

1 необходимо повторное изучение 0 – 20 

В зачетно-экзаменационную ведомость и зачетную книжку выставляются оценки 

по пятибалльной шкале и рейтинговые оценки в баллах.  

При получении студентом на зачёте неудовлетворительной оценки в ведомость 

выставляется рейтинговая оценка в баллах (<40 баллов), соответствующая фактическим 

знаниям (ответу) студента.  

Общее количество баллов по дисциплине - 100 баллов. 

Максимальное количество баллов, которое можно набрать в течение семестра за 

посещаемость, выполнение лабораторных и домашних заданий, тестирование и 

самостоятельную работу – 80 баллов. 

За посещение лекционных занятий и написание конспектов обучающийся может 

набрать максимально 15 баллов. 

За выполнение домашних заданий обучающийся может набрать максимально 10 

баллов (5 заданий по 2 балла). 

За подготовку конспектов по самостоятельной работе обучающийся набрать 

максимально 10 баллов. 

За выполнение лабораторных работ обучающийся может набрать максимально 30 

баллов (15 работ по 2 балла). 
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За тестирование обучающийся может набрать максимально 15 баллов (15 тестовых 

вопросов по 1 баллу за каждый). 

Максимальная сумма баллов, которые обучающийся может набрать при сдаче 

зачета, составляет 20 баллов. 

Для сдачи зачета с оценкой по дисциплине необходимо выполнить все требуемые 

лабораторные работы (получить допуск к зачету у преподавателя, проводившего 

лабораторные работы). Существенным моментом является посещаемость занятий (в 

случае пропусков занятий предполагается более подробный опрос по темам пропущенных 

занятий). На зачет выносится материал, излагаемый в лекционном курсе и 

рассматриваемый на лабораторных занятиях. Для получения зачета надо правильно 

ответить на несколько поставленных вопросов. В затруднительных ситуациях (в 

отдельных случаях) допускается на зачете воспользоваться тетрадью с записью 

материалов лекций и семинаров в присутствии преподавателя. При этом преподаватель 

может убедиться, в какой степени студент ориентируется в «своих» материалах, и по ряду 

дополнительных вопросов (по тетради) решить вопрос о зачете. 

При пересдаче зачета с оценкой используется следующее правило для 

формирования рейтинговой оценки:  

- 1-я пересдача – фактическая рейтинговая оценка, полученная студентом за ответ, 

минус 5 (баллов); 

- 2-я пересдача – фактическая рейтинговая оценка, полученная студентом за ответ, 

минус 8 (баллов). 

Учет посещаемости лекционных и лабораторных занятий осуществляется по 

ведомости, представленной ниже в форме таблицы. 

 

Московский государственный областной университет 

Ведомость учета посещения 

Физико-математический факультет 

 

Направление подготовки: 44.03.01 - Педагогическое образование 

Профиль подготовки: Информатика 

Дисциплина: Микропроцессорное управление проектной деятельности 

Группа: 41 

Преподаватель: Шевчук М.В. 

 

№ 

п/п 

Фамилия 

И.О. 

Посещение занятий 

 

Итого 

 

1 2 3 4   ……………….… 18 

1. Иванов И.И. + - + -    + 10 

2. Петров П.П. - + + +    + 8 

           

 

Московский государственный областной университет 

Ведомость учета текущей успеваемости 

Физико-математический факультет 

 

Направление подготовки: 44.03.01 - Педагогическое образование 

Профиль подготовки: Информатика 

Дисциплина: Микропроцессорное управление проектной деятельности 

Группа: 41 

Преподаватель: Шевчук М.В. 

№ Ф. Сумма баллов, набранных в семестре Обща Итоговая Подпись 
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Структура оценивания домашних заданий 

 

Критерии оценивания Баллы 

Аккуратность и полнота выполнения всех пунктов задания 0-1 

Понимание логики выполнения задания и значения полученных результатов 0-1 

 

 

Критерии и шкала оценивания конспекта 

 

Критерий Баллы 

Текст конспекта логически выстроен и точно изложен, ясен весь ход 

рассуждения 

0-1 

Даны ответы на все поставленные вопросы, изложены научным языком, с 

применением терминологии 

0-1 

 

Шкала оценивания тестовых вопросов  

 

Критерий оценивания Баллы 

Дан верный ответ на вопрос теста 1 

Дан неверный ответ на вопрос теста 0 

Максимальное количество баллов за один вопрос 1 

 

Структура оценивания лабораторных работ 

 

Критерии оценивания Баллы 

Аккуратность и полнота выполнения всех пунктов задания 0-1 

Понимание логики выполнения задания и значения полученных результатов 0-1 

 

Структура оценивания зачета с оценкой 

 

п/п И.О. я 

сумм

а 

балло

в 

(макс

. 100) 

оценка преподавате

ля 

Посе

щ. 

до 15 

балло

в 

Лаб. 

работ

ы 

до 30 

балло

в 

Вып. 

дом. 

задан

ий до 

10 

балло

в 

Вып. 

консп

. до 

10 

балло

в 

Тести-

рован

ие до 

15 

балло

в 

Зач. с 

оцен-

кой 

до 20 

балло

в 

Циф

ра 

Пропис

ь 
 

1 2 3 4 5 6 7 8 9 10 11 12 

1. 

Иван

ов 

И.И. 

6 8 6 15 
Шевч

ук 
19  4 хор. Шевчук 

2. 

Петр

ов 

П.П. 

7 7 6 20 
Шевч

ук 
10  4 удовл. Шевчук 
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Уровни оценивания Критерии оценивания Баллы 

оценка «отлично» Ставится, если студент обнаруживает  

всестороннее, систематическое и глубокое знание 

программного материала по дисциплине; 

обстоятельно анализирует структурную 

взаимосвязь рассматриваемых тем и разделов 

дисциплины; усвоил основную и знаком с 

дополнительной литературой, рекомендованной 

программой, а также усвоил взаимосвязь основных 

понятий дисциплины в их значении для 

приобретаемой профессии; проявил творческие 

способности в понимании, изложении и 

использовании учебного материала. 

16-20 

оценка «хорошо» Ставится, если студент, обнаруживает полное 

знание программного материала, успешно 

выполняет предусмотренные в программе задания; 

усвоил основную литературу, рекомендованную в 

программе; показал систематический характер 

знаний по дисциплине и способен к их 

самостоятельному пополнению и обновлению в 

ходе дальнейшей образовательной деятельности. 

11-15 

оценка 

«удовлетворительно» 

Ставится, если студент обнаруживает знание 

основного программного материала в объеме, 

необходимом для дальнейшего обучения и 

профессиональной деятельности; справляется с 

выполнением заданий, предусмотренных 

программой; знаком с основной литературой, 

рекомендованной программой; допускает 

погрешности непринципиального характера в 

ответе на экзамене. 

6-10 

оценка 

«неудовлетворительно» 

Ставится в том случае, если студент обнаруживает 

пробелы в знаниях основного программного 

материала, допускает принципиальные ошибки в 

выполнении предусмотренных программой 

заданий. 

0-5 

 

Структура оценивания курсовой работы 

 

Уровни оценивания Критерии оценивания Баллы 

оценка «отлично» Выставляется за курсовую работу, которая носит 

исследовательский характер, имеет грамотно 

изложенный теоретический раздел, 

характеризуется логичным и последовательным 

изложением материала с соответствующими 

выводами и обоснованными предложениями по 

практическому применению результатов 

исследования; при ее защите обучающийся 

показывает глубокие знания вопросов темы, 

свободно оперирует данными исследования, 

81-100 
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Уровни оценивания Критерии оценивания Баллы 

вносит обоснованные предложения по 

практическому применению результатов 

исследования, четко отвечает на поставленные 

вопросы. 

 

оценка «хорошо» Выставляется за работу, которая носит 

исследовательский характер, имеет грамотно 

изложенный теоретический раздел, 

характеризуется логичным и последовательным 

изложением материала, однако имеет не вполне 

обоснованные выводы и не имеет предложений по 

практическому применению результатов 

исследования; при ее защите обучающийся 

показывает знание вопросов темы, оперирует 

данными исследования, без особых затруднений 

отвечает на поставленные вопросы. 

 

61-80 

оценка 

«удовлетворительно» 

Удовлетворительно» выставляется за работу, 

которая носит в большей степени описательный, а 

не исследовательский характер; работа имеет 

теоретический раздел, базируется на практическом 

материале, но характеризуется 

непоследовательностью в изложения материала; 

представленные выводы автора плохо обоснованы; 

при ее защите обучающийся проявляет 

неуверенность, показывает слабое знание вопросов 

темы, не дает полного аргументированного ответа 

на заданные вопросы. 

41-60 

оценка 

«неудовлетворительно» 

Выставляется за работу, которая не носит 

исследовательского характера и не отвечает 

требованиям, предъявляемых к выполнению 

курсовых работ; в работе нет выводов, либо они 

носят декларативный характер; при защите 

курсовой работы обучающийся затрудняется 

отвечать на поставленные вопросы по теме, не 

знает теории вопроса, при ответе допускает 

существенные ошибки; к защите не подготовлены 

наглядные пособия и раздаточные материалы. 

0-40 

 




